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Telemédia 
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4º Ano – Licenciatura em Comunicação Social 

Trabalho Prático: Edição não Linear de Vídeo 
 

 
A. Objectivos 

 
Pretende-se com este trabalho dar a conhecer aos alunos os conceitos básicos do 
Vídeo Digital  e transmitir as competências práticas e teóricas  necessárias para que os 
alunos sejam capazes de produzir  um filme do princípio ao fim de acordo com um 
guião previamente definido1, nomeadamente:  
 

1- Gravar os trechos vídeo e som   necessários usando dispositivos  de 
captura  

2- Alternativamente poderão ser usadas trechos vídeo ou som já 
existentes em suporte  analógico ou digital  

3- Importação dos trechos de vídeo e som para um ambiente de edição 
não linear de vídeo  

4- Edição dos trechos individuais 
5- Montagem do filme com base no conjunto de trechos de vídeo  com a 

introdução de transições, legendas e efeitos especiais.  
6- O filme produzido deverá ter quer o som gravado nos trechos, quer 

narração e efeitos sonoros.   
7- Gravação do filme produzido  em DVD, VHS ou CD-ROM  ou em 

formato adequado  publicação  do filme no Web. 
 
Estes conhecimentos serão demonstrados  quer com: 
 

1. Publicação pelos alunos na sua área WWW  do filme (em ficheiro compactado 
e cópia única)  cuja montagem corresponde ao procedimento proposto neste 
tutorial. 

2. Elaboração dum filme, cujo tema é escolhido alunos, com um máximo de 30 
segundos que inclua o seguinte: 

a. Dois ou mais trechos vídeo interligados por transições com o som 
correspondente.  

i. Um dos trechos será a filmagem dos autores do trabalho e não 
deverá ultrapassar os 5 segundos.  

ii.  Os outros trechos poderão ser ou não vídeos capturados pelos 
alunos. Os trechos de vídeo capturados serão obviamente mais 
valorizados.  

b. Título e ficha técnica correspondente 
c. Um ou mais efeitos especiais vídeo e áudio 
d. Inserção de imagem  animada. 
e. O filme deverá ser acompanhado com uma página A4 de relatório 

                                                                 
1 Que espero aprendam  a fazer na cadeira da especialidade 
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O filme, no formato QuickTime deverá ser publicado no WWW  em cópia única e 
compactado com um apontador na página WWW correspondente ao relatório. 
  A datas de entrega serão definidas oportunamente pelos docentes. O trabalho será 
realizado em Grupos de 2 estudantes. A realização do trabalho em grupo é 
obrigatória. 
 

B. Organização do Trabalho 
 
Pelo facto de não existirem  verdadeiras Estações de Edição de  Vídeo no Laboratório 
0.03 do DI, partes deste trabalho não poderão ser realizadas pelos alunos durante as 
aulas.  
Para além dos vídeos disponibilizados para o tutorial que estão na pasta Tour do 
Premiere, poderão ser gravados vídeos usando a WebCam disponível na estação de 
trabalho. 
Quer para gravação dos seus trechos como para montagem do filme os alunos poderão 
utilizar material disponibilizado no Laboratório de Vídeo do Departamento de 
Comunicação Social, no CPI  . Os horários de utilização do Laboratório bem como a 
utilização de equipamento   de captura deverão ser combinados entre os alunos e o 
responsável pelo Laboratório, o Sr. Fernando. 
 

C. Pré- Requisitos  
 
É necessário um equipamento para captura de trechos vídeo (analógico ou digital), 
como por exemplo uma câmara de vídeo.  Se optar pela utilização de trechos vídeo já 
existentes tem que dispor das fontes em formato analógico (cassete VHS) ou digital 
(CD ROM ou DVD).  
 
Todo o trabalho de edição será feita normalmente numa Estação de Vídeo que é um 
PC artilhado com Windows com uma placa de aquisição de vídeo (Pinnacle) e os 
dispositivos apropriados para importação das trechos vídeo e a exportação do filme 
para o suporte adequado. Nessa estação estará instalado o pacote Adobe Premiere 6.0 
que aprenderemos a usar neste tutorial.  
 
Caso opte pela utilização das estações de trabalho do Laboratório 0.03  poderá apenas 
usar trechos de vídeo com fraca resolução e um número baixo  de quadros por 
segundo devido a limitações de espaço em disco. Os trechos a usar deverão ser 
transportados usando disquetes, CD-ROM ou um dispositivo portátil que possa ser 
ligado ao seu PC usando a interface USB.  Não se esqueça de usar ,sempre que possa, 
programas de compactação para diminuir o tamanho de trechos vídeo, áudio e de 
imagens. Faça uma limpeza prévia da sua área de trabalho para evitar dissabores com 
problemas de falta de espaço em disco.  
 

D. O Adobe Premiere 
 

Com o Adobe Premiere podemos capturar, importar, montar e editar vídeo, áudio e 
imagens. O Premiere disponibiliza um conjunto de janelas e paletas, permitindo que 
nos concentremos nos aspectos mais criativos no desenvolvimento do nosso projecto 
vídeo. Uma série de módulos de exportação permitem-nos exportar o nosso vídeo 
para Web, cassete vídeo e CD-Rom. 
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O Premiere organiza as funções de edição em janelas especializadas. Isto dá-nos a 
flexibilidade para uma organização das janelas adaptada ao nosso estilo de edição. As 
paletas flutuantes dão-nos informação e acesso rápido a qualquer parte do nosso 
programa de vídeo. Podemos arrumar as janelas e paletas para fazer uso eficiente do 
computador e dos monitores de televisão. 

 
 Instalação do Software 
 

Comece por instalar o Pacote Adobe Premiere 7.0 

a) Usando o Windows Explorer  monte como uma drive virtual  \\\\\\\\smbsrvsmbsrvsmbsrvsmbsrv\\\\installinstallinstallinstall onde está o 

software que está disponível para instalação 
b) Mude-se para directoria macedo e  copie  a licença para o Adobe Premiere que está no 

ficheiro  serials.txt. Utilize o wordpad ou o notepad. 
 

c) Na pasta Adobe Premiere  inicie o procedimento de instalação executando o programa 
setup.exe. 

 
d) Existe uma pasta Tour com clips e imagens necessários para realização deste trabalho. Pode 

transferi-los para a sua área de trabalho.  
 
AVISO IMPORTANTE: Deve-se esquecer completamente desse número para não ser tentado a 

usá-lo noutras circunstâncias, sob pena de criar embaraços sérios ao proprietário desta licença 

que é o Departamento de Comunicação Social da Universidade do Minho. 

 
E. O Começo 
 

O programa Premiere é executado como se executa todos os programas no Sistema 
Operativo Windows. 

1. Start > Programs > Adobe > Premiere 6.0 > Adobe Premiere 6.0 
 

No Premiere, se executar o programa pela primeira vez ou se tiver apagado as 
preferências (ficheiro PREM60.PRF, na mesma pasta onde está o programa 
executável do Premiere), aparece  a caixa de selecção  do espaço de trabalho 
(Workspace). Os exercícios realizados neste trabalho são feitos no modo de edição de 
pista simples (Single-Track).  
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O espaço de trabalho de edição em modo A/B  
 
É  usado principalmente para mover trechos vídeo da janela do projecto para a janela 
da linha de tempo (Timeline). Este modo assemelha-se ao método convencional de 
edição chamado Edição com duas cassetes vídeo A e B e um comutador de efeitos 
para disponibilizar as transições. Uma vez seleccionado este modo ficam 
estabelecidas as seguintes condições: 
 
O janela do Monitor usa uma única vista, mostrando apenas a janela de visualização 
do programa e os controladores. Os trechos vídeo são abertos noutra janela.  
A janela da Linha de Tempo mostra a pista de vídeo 1 expandida, com uma pista de 
transição entre Vídeo 1A  e 1B. Estão disponíveis todas as paletas, estando activas as 
paletas do Controlo de Efeitos, Navegador e Transições. 
 
 O espaço de trabalho de edição em modo de pista única  
 
É usado para técnicas de edição mais avançadas e para trabalhar com a pista Vídeo 1 
como única pista. 
A janela do Monitor disponibiliza uma vista dual, mostrando uma vista fonte e uma 
vista do programa, lado a lado. Os  trechos vídeo são colocados na vista fonte para 
ajustes e estabelecimento de pontos de entrada e saída. São posteriormente colocados 
na janela da linha de tempo para posicionamento. 
 
A Janela da Linha de Tempo tem uma única pista Vídeo 1 em que são combinadas as 
pistas de vídeo e de transição. Todas as ferramentas funcionam nas três  sub-pistas 
como se tratasse duma única para inserções, sobreposições e ajustes. Esta pista pode 
sempre ser expandida. 
 
Espaço de trabalho de efeitos 
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Disponibiliza acesso tanto aos efeitos áudio como vídeo usa o espaço de trabalho em 
uso (pista única ou A/B) com os ajustamentos seguintes: a janela do Monitor 
disponibiliza uma única vista, estando activas as paletas do Controlo de Efeitos, 
Navegador e Transições. 
  
Espaço de trabalho áudio 
 
Disponibiliza acesso  às ferramentas para edição das pistas áudio usa o espaço de 
trabalho em uso (pista única ou A/B) com os ajustamentos seguintes: Os trechos são 
abertos numa janela diferente, a janela áudio fica aberta e não são mostradas paletas.  
 
 

2. Para este  tutorial vamos seleccionar  o modo Single-Track-Editing  
 

 
 

3. No Load Project Settings use Multimedia Quicktime . 
 
 
Na caixa de diálogo de parametrização do Projecto (Project Settings) , devemos 
configurar o projecto de acordo com o material fonte disponível. Nesse caso deve ser 
usado o formato de saída do nosso dispositivo de captura.  
 
O Adobe Premiere 6.0 é muito fácil de configurar. Quando estiver a trabalhar no seu 
projecto, se não encontrar os parâmetros adequados para o seu vídeo, seleccione os 
parâmetros mais próximos do nosso ambiente de edição e depois usa-se a opção 
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Costum, especifica-se a configuração do nosso projecto e depois guarda-se a 
configuração com Save.   
 
Uma vez  que escolha o OK na configuração do Projecto aparece a janela da aplicação 
Premiere. Vê-se o espaço de trabalho (Workspace) no modo de edição de pista 
simples (Single-Track) e as suas três janelas  principais ( Projecto, Monitor e Linha de 
Tempo) e as paletas  por defeito.  Se necessário, podemos arrumar  as janelas e paletas 
usando Window->Workspace->Single-Track Editing. Os componentes do espaço de 
trabalho arrumam-se automaticamente.  
 

 
 
 

F. Verificação dos parâmetros de  configuração do projecto 
 
Uma vez iniciado  um projecto podemos verificar a sua configuração em qualquer 
instante. 

1- Na barra de menus  do Premiere, no topo do nosso ecrã  escolha 
Project->Project Settings ->Video.  É mostrada a  configuração actual 
do Vídeo. Podemos modificá-la e visualiza-la novamente.  

2- Clique noutra taxa de quadros diferente da actual. Por exemplo 15 
quadros por segundo.  

3- Clique em seguinte (next) para visualizar todas as janelas de 
configuração do projecto. 

Os parâmetros de configuração do projecto estão organizados em cinco categorias: 
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Genéricos  Controlam as características fundamentais do programa, incluindo o modo 
de edição a contagem do tempo  (Time Display) e  a reprodução do vídeo (Timebase). 
 

 
 
Vídeo  Controlam o tamanho do quadro, qualidade da imagem, método de 
compressão utilizada e a proporção entre a largura e o comprimento do quadro usados 
na reprodução do vídeo. 
Áudio Controla as características do áudio reproduzido a partir da Linha de Tempo. 
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Opções de Quadros Chave e Apresentação (rendering) Controla as características 
relacionadas com o quadro quando se constrói e reproduz visualizações prévias da 
Linha de Tempo. Estas opções trabalham em conjunção com os parâmetros do vídeo. 
 

 
 
Captura  Controlam a forma como o Premiere transfere o vídeo e o áudio 
directamente do gravador ou da câmara (Os outros parâmetros do projecto não 
influenciam a captura). 
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4- Clique OK para aceitar temporariamente a nova Taxa de Quadros para 

este projecto 
5- Aparece uma caixa de diálogo a indicar que os parâmetros do vídeo 

mudaram. Clique OK. 
6- Na barra de título do Premiere escolha Project->Settings Viewer. 

 
Podemos usar esta opção para visualizar e comparar todos os parâmetros para o 
projecto e os  trechos de vídeo utilizados, bem como os usados na captura e 
exportação de ficheiros. Evita-se potenciais conflitos pela concordância dos 
parâmetros  usados nas diferentes categorias. Na maioria dos casos, os parâmetros de 
captura, projecto e exportação devem ser os mesmos para todos os trechos vídeo. 
 

 
 
 
 
G. Criar um novo projecto 
 
Estamos agora em condições de começar a criar o filme. 

1. Escolha File->New Project 
2. A caixa de diálogo dos parâmetros do projecto aparece novamente. 

Seleccione os parâmetros de acordo com os conselhos dados 
anteriormente. 

3. Depois de pressionar  OK vamos ver o espaço  de trabalho em modo de 
edição  numa única pista  e as suas janelas e paletas associadas. 

4. Escolha  Edit->Preferences->General and Still Images  e desligue a 
selecção Open Movies na janela do Trecho(Clip), se for o caso. 

 
Podemos agora  importar os trechos que vão ser usados pelo programa de vídeo. Um 
trecho pode ser um filme, imagem ou sequência de imagens, áudio em formato digital. 
Há várias formas de importar trechos para o projecto. Neste trabalho vamos importá-
los directamente para a janela do Projecto. É o local onde o Premiere coloca todos os 
trechos fonte importados embora não tenham necessariamente que ser usados.  
 
Uma janela de projecto inclui uma área bin, que mostra os binários que foram 
adicionados ao projecto. A área bin  aparece na parte esquerda da janela do projecto, 
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e pode ser redimensionada ou escondida. Quando há uma hierarquia de bins aparece a 
respectiva imagem gráfica.  

5. Para importar trechos de filme  temos que escolher File->Import ->File  
e seleccionar a directoria com os trechos a importar.Vamos importar 
para já o zfinal.mov que está na pasta do Tour. Aparece uma janela 
com o trecho.  

6.  Clicando em Play o trecho é mostrado na janela do monitor. Se isso 
não acontecer faça primeiro Clip->Open Clip. 

 
 
 
 
 

 
 
 

7. Quando terminarmos de visualizar podemos usar File->Close. Se 
fechar a janela do monitor e preferir mantê-la aberta torne a activá-la. 

8. Vamos agora importar os trechos que estão na pasta do Tour. Para isso 
clicamos em File->Import 
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Os ficheiros seleccionados aparecem na janela do projecto. Para cada ficheiro 
importado a janela do projecto mostra o nome, duração e tipo. 

 
9. Antes de continuar tem que dar um nome ao ficheiro e salvar o 

projecto. Depois de indicar o nome do ficheiro (ciclistas.mov) e a pasta 
onde o colocar, use File->Save.  

 
  
  

H. Captura de Trechos Vídeo  
 
Esta parte  é independente e  corresponde aos passos necessários para capturar 
trechos Vídeo. Eventualmente faz sentido salvar o projecto  anterior e abrir um 
novo apenas para realizar a captura. No caso do Laboratório de Ensino no DI só é 
possível a captura usando a WebCam. 
 
    Utilização da Pinnacle 

 
1- Arranque a janela de captura de filme (movie capture) usando o menu 

File e os comandos Capture e Movie Capture. 
 

Abre-se a janela de captura. Quando o dispositivo de Vídeo Digital é ligado (modo 
VCR) aparecem automaticamente os botões de controlo na parte inferior da janela de 
Visualização Prévia.   Contudo se for usado um dispositivo analógico, em vez dos 
botões de controlo aparece apenas o botão de gravação (record).  
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Antes de podermos gravar trechos de vídeo no Adobe Premiere, temos que 
seleccionar  o disco a usar para gravação.  
 

 
 
Tem que ter velocidade e espaço suficientes para capturar o vídeo. Isso pode ser 
testado com a ferramenta DVExpert. Pode usá-la da seguinte forma: Starts-
>Programs->Pinnacle DV Plus->Tools->DVExpert.   
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Quando grava pela primeira vez o Premiere pergunta automaticamente pelo disco para 
gravação. Ao seleccionar o disco proceda da seguinte forma: 

2- Clique no botão de edição e na área de Preferências . Abre-se a janela 
das preferências. 

3- Seleccione a pasta de destino no disco rígido sob Scratch Disks.  Na 
area de controlo de dispositivos  deve ser colocado  Pinnacle DV 
Device Control. No caso dum dispositivo analógico  não há controlo de 
dispositivo. Feche a janela com OK. 

4- Os parâmetros da configuração do projecto serão mostrados na área de 
parametrização da captura (capture settings). Abra a janela de 
parametrização do projecto com o botão Edit. Clique no botão de 
Settings. Aparece  janela de parametrização da Pinnacle DV500. 

• Tabela de Entrada de Vídeo: Escolha a entrada a que a sua 
fonte de vídeo está ligada e ajuste os valores de brilho, 
contraste conforme necessário (apenas disponível nos 
dispositivos analógicos) 

• Tabela de Formato de Vídeo: Para selecção da norma vídeo e 
do tamanho do quadro (frame size). 
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• Tabela de Entrada de Áudio: Para escolha da entrada de áudio 
e o formato de gravação áudio. Pode-se também ajustar o 
nível de gravação áudio se necessário 

• Tabela Genérica: Escolher os parâmetros de overlay. 
5- Clique agora em OK para aceitar os novos valores e fechar a janela de 

diálogo 
6- Clique no botão de gravação na  janela de captura de filme. Quando 

está disponível o controlo do dispositivo, a função de gravação 
(Record) é mostrada a vermelho entre os vários comandos de controlo 
do dispositivo.  A captura será começada. O vídeo é mostrado no 
monitor do PC e começa a gravação. 

7- Verifique o progresso da visualização na janela de captura do filme. Se 
notar que há quadros a serem descartados (frames dropped), clique no 
ESC para terminar a gravação. Verifique se os recursos do seu  sistema 
são adequados para a configuração utilizada. 

8- Quando capturar o material vídeo, clique na tecla ESC para terminar a 
gravação. Aparece uma janela de diálogo para introduzirmos o nome 
do ficheiro. O trecho vídeo é automaticamente incorporado na janela 
de projecto do Premiere. 

9- Repita o procedimento um certo número de vezes 
 
  Nota: No Adobe Premiere há outras maneiras que podem ser usadas para 
capturar vídeo duma fonte de vídeo DV. Uma é gravar usando os pontos 
de entrada e saída e outra é fazer uma captura por lotes. 
 
10- Fechar a janela de captura de filme 

 
O dispositivo DV pode ser desligado na fase de edição do vídeo. Durante a edição use 
a cablagem  analógica para visualizar no monitor de TV os efeitos em tempo real. 
Uma vez  terminado o projecto podemos ter que ligar novamente o projecto DV para 
guardar o projecto. 
 
Utilização da WebCam 
 
Este mesmo procedimento poderá ser efeito usando  a WebCam. Se estiver no 
Laboratório do DI onde decorrem as aulas, esta será a única alternativa. Seleccione 
como formato para Vídeo o Video For Windows.  
 



 15

 
 
  
Posto isto se usat File->Capture aparece a janela com a imagem da WebCam. Na 
primeira vez que usa pode aparecer uma caixa de diálogo para se confirmar se a 
WebCam é o dispositivo de captura a utilizar. Tem que se ter paciência durante o 
período em que se está a fazer captura porque o programa pode se tornar bastante 
lento. 
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Captura de vídeo em lotes 
 
Se dispuser dum gravador  com precisão nos quadros ou uma câmara de vídeo portátil 
que suportem controlo dum dispositivo externo e uma cassete de vídeo gravada com 
código de tempo (timecode), pode configurar o Premiere para uma captura automática  
de trechos múltiplos duma mesma cassete. Isto é chamado a captura em lotes. 
Podemos criar uma lista dos segmentos que desejamos capturar da cassete, usando a 
janela de captura em lotes (Batch Capture).  A lista (chamada batch list ou timecode 
log).  Pode ser criada pelo registo de trechos visualmente usando o controlo de 
dispositivo ou  definindo manualmente pontos de entrada e saída (IN e OUT). Para 
adicionar uma entrada nova na janela de captura por lotes, clique em Add Icon. 
Quando a lista do lote estiver pronta, clique no botão de captura  para dar início à 
captura dos trechos vídeo do lote.   
 
Use File->Capture->Batch Capture, para abrir e familiarizar-se com a janela de 
captura em lotes. 
 
Qualidade na Captura de Vídeo 
 
Há vários componentes que afectam  a qualidade do vídeo  capturado. 
 
A captura de vídeo exige um desempenho do computador mais consistente e mais 
elevado. O desempenho necessário é bastante superior  ao requerido pelas aplicações 
de automação de escritório mais genéricas  e mesmo para o software de edição de 
imagens.  A obtenção de resultados profissionais depende da capacidade conjunto dos 
componentes do sistema utilizado na transferência de quadros da placa de aquisição 
para o processador e depois para o disco rígido.  
 
A capacidade do nosso sistema capturar vídeo depende da capacidade combinada dos 
seguintes componentes: 
 
Placa  de Aquisição Vídeo  
 
Precisamos duma placa de aquisição de vídeo instalada ou uma funcionalidade 
equivalente para transferir vídeo duma determinada fonte externa (câmara de vídeo, 
gravador, etc...) para o disco rígido. Não confundir placa de aquisição de vídeo com a 
habitual placa de vídeo que existe em todos os computadores. Há uma serie de placas 
vídeo que estão certificadas para uso com o Adobe  Premiere versão Y.*. 
 
A placa de aquisição vídeo deve ser suficientemente rápida para gravar o vídeo com o 
nível de qualidade necessário ao média final. Para vídeo NSTC em ecrã total e com 
todo movimento, a placa deve ser capaz de capturar 30 quadros2 com 640*480 pixels  
por segundo, sem descartar quadros;  para vídeo PAL ou SECAM , 25 quadros3 com 
720*576 pixels  por segundo. Mesmo para Vídeo na Web, em que se usa um tamanho 
e taxa de quadro menor, é desejável usar a máxima qualidade possível na captura. 

                                                                 
2 ou 60 campos 
3 ou 50 campos 
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Esta opção é a melhor desde que haja disco suficiente. Se gravarmos com baixa 
qualidade temos menos  opções em tempo de codificação.  
 
 
Disco Rígido 
 
O disco armazena os trechos vídeos capturados. Deve ser suficientemente rápido para  
guardar os quadros de vídeo seja qual for a rapidez com que chegarem da carta de 
aquisição; caso contrário, os quadros são descartados. Para capturar vídeo difundido 
de acordo com a norma NSTC, o disco deve ter um tempo de acesso médio de 10 
milisegundos  e uma taxa de transferência de dados de pelo menos 3MB por segundo 
– de preferência à volta de 6MB/seg.  
O tempo de acesso é a velocidade com que o disco rígido encontra uns  dados 
específicos. 
A taxa de transferência de dados  é velocidade com que o disco é capaz de transferir 
informação de e para o resto do computador.  Devido  a factores  como a sobrecarga 
do sistema,  a taxa de transferência efectiva para a captura de vídeo é  cerca de metade 
da taxa de transferência especificada para a unidade de disco. 
Para obter melhores resultados utilize um disco separado para a captura e edição de 
vídeo, de preferência de alto desempenho. A tecnologia de armazenamento muda 
rapidamente pelo que é melhor consultar informação dos respectivos fabricantes para 
escolher o sistema de armazenamento de vídeo. 
 
Processador (CPU4) 
 
O processador do seu computador (Pentium X5)  trata das tarefas genéricas de 
processamento no computador. Tem que ser suficientemente rápido para processar os 
quadros à taxa utilizada. Um CPU mais rápido (ou vários CPUs num sistema) é 
melhor. Contudo, os outros componentes do sistema devem ser suficiente rápidos para 
acompanhar a pedalada do processador. CPU rápido com os outros componentes 
lentos é como conduzir um F1 numa estrada com engarrafamento! 
 
Barramento 
 
Todo o computador tem um barramento de dados que interliga  os seus componentes e 
transfere dados entre eles. A sua velocidade de transferência determina a rapidez com 
que o computador  é capaz de  transferir  quadros entre a placa de aquisição, o CPU e 
o disco. Se tiver comprado um PC especificamente para ser usado como estação de 
edição de vídeo, estes problemas podem estar resolvidos à partida. Se aumentou a 
capacidade dum computador já existente com uma placa de aquisição pode ser que o 
barramento lento seja o engarrafamento do sistema. 
 
Genericamente, quando se adiciona um novo componente a um PC temos que nos 
assegurar previamente se o barramento permite tirar partido dele.  
 
Codec (Compressor/Descompressor) 
 

                                                                 
4 Central Processing Unit  , na terminologia inglesa. 
5 III ou IV de acordo com o computador 
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A maioria das placas de aquisição de vídeo  incluem um circuito integrado de 
compressão que mantém a taxa de transferência de dados num nível que o 
computador pode manipular. Se o hardware de captura vídeo não tiver esse chip, 
podemos capturar usando um codec rápido e de alta qualidade como o Motion JPEG. 
Se se capturar usando um codec de baixa compressão e com perdas (como o 
Cinepak), descartamos quadros e perdemos qualidade. 
 
 
Tempo de Processamento  de outro Software 
 
Se a captura for feita ao mesmo tempo que se corre outros programas (ligações de 
rede, salvaguarda do ecrã, melhorias não essenciais para o sistema), os outros 
programas vão interromper provavelmente a captura com pedidos de tempo de CPU, 
provocando o descarte de pacotes. Quando capturar vídeo utilize o computador  com o 
mínimo de drivers e outros programas.  
 
Captura para suportar edição em linha e em deferido 
 
Dependendo do nível de qualidade pretendido e as capacidades do equipamento 
utilizado, pode-se usar o Premiere para edição em linha e em deferido. A 
parametrização é diferente para estes dois tipos de edição. 
 
Edição em Linha 
 
A prática de realizar toda a edição utilizando os mesmos trechos fontes que vão ser 
usados para produzir a versão final. Como os computadores são cada vez mais 
potentes, a edição em linha tornou-se praticável para uma larga gama de produções 
como difusão de TV e produção de filmes. Para a edição em linha a captura dos 
trechos tem que ser feita duma vez, com a melhor qualidade que o nosso computador 
e periféricos sejam capazes de manipular. 
 
Edição em Deferido 
 
A prática de preparar uma versão preliminar  a partir de trechos de vídeo de menor 
qualidade e então produzir uma versão final, eventualmente num sistema de maior 
capacidade.  A edição em deferido podem ser úteis mesmo quando o computador é 
capaz de editar na qualidade da versão final. Capturar em lotes vídeo com parâmetros 
de baixa qualidade, permite editar mais depressa usando ficheiros mais pequenos. Na 
digitalização de   vídeo   para edição em deferido, especificam-se parâmetros que 
enfatizam a velocidade de edição em detrimento da qualidade das imagens. Na 
maioria dos casos, precisa-se apenas da qualidade necessária para identificar 
correctamente o quadro inicial e final de cada cena. Para criar a versão final, pode-se 
voltar a digitalizar o vídeo  com melhor qualidade. 
 
Quando se termina a edição em deferido no Premiere, pode-se criar uma tabela de 
sequência de cenas chamada Lista de Decisões da  Edição ou EDL.  A EDL pode ser 
transferida para um controlador de edição e então ser aplicada a um original de maior 
qualidade. 
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I. Visualização Prévia na Janela do Monitor 
 
Para verificar como o trabalho está a progredir podemos visualizar previamente 
um ou mais trechos de vídeo na janela do Monitor. O  Monitor de visualização 
dual mostra as vistas  da fonte e do programa. 
 
 Vista da fonte (janela da esquerda) 
 
Permite visualizar o trecho, seleccionar pedaços  e inseri-lo na janela da linha de 
tempo. Esta vista pode armazenar muitos trechos ao mesmo tempo, mas só se 
pode manipular um de cada vez.  
  
Vista  do programa (janela da direita) 
 
Permite visualizar o programa inteiro de vídeo, em qualquer altura. Esta vista 
permite visualizar a sequência de trechos na janela da Linha de tempo. Também 
podemos usar esta vista para editar o programa de vídeo. 
 

1- Se a janela do Monitor não estiver ainda aberta, escolha Window-
>Monitor 

 

 
 
2- Na janela do Monitor, carregue no botão Play (4) na parte inferior da 

vista do programa ou carregue na tecla espaço do seu  teclado uma vez 
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para correr a  versão em bruto do seu programa vídeo. Este botão de 
Play pode não funcionar se não tiver trechos na janela da linha de 
tempo. 

3- Para tornar a correr o seu programa, carregue novamente no botão de 
Play ou click no botão de Loop (ciclo) para correr o programa vídeo 
em ciclo. Para terminar carregue no botão Stop ou  ou carregue na tecla 
espaço do seu  teclado. 

 
Agora que a versão em bruto do seu programa de vídeo o satisfaz  (os trechos 
componentes a usar),  os próximos passos são editar os trechos, adicionar som, 
transições, efeitos especiais e sobrepor imagens para criar a versão final do seu 
filme vídeo. 

 
 
J. Edição dos  Trechos Vídeo 
 
Quando gravamos alguma coisa com uma câmara, geralmente produzimos muito 
mais material do que podemos usar no nosso programa vídeo, Para criar cenas, 
gravações e transições temos que remover dos trechos partes  não desejadas. Essa 
selecção é uma parte essencial  da criação dum programa vídeo, algo que 
precisamos de fazer inúmeras vezes. O Premiere disponibiliza uma série de 
maneiras  para editar trechos, que vão desde ferramentas de corte rápido de 
versões em bruto até as mais precisas que permitem visualizar quadro a quadro. 
 
Vamos começar a editar o vídeo  manipulando o ficheiro Boys.mov (o primeiro 
trecho do programa vídeo). 
 

1- Clique na barra de título da  janela Timeline  para a activar 
2- Arraste o ficheiro Boys.mov para a pista 1 de vídeo da janela da Linha 

de tempo. A seguir coloque os trechos  Cyclers.mov, Fastslow.mov  e 
Finale.mov na mesma pista uns a seguir aos outros 

3- Na pista Vídeo 1 da janela Timeline, clique duas vezes no trecho 
Boys.mov 



 21

 
 
O primeiro quadro do trecho Boys.mov aparece na vista fonte (source)  da janela 
do Monitor.  
Antes de o editar, visualize o trecho.  
 

4- Carregue no botão Play por baixo da vista Source  da janela do 
Monitor, ou carregue na tecla de espaço. 

5- Conforme está agora o trecho é muito longo, temos que remover umas 
partes. Isso corresponde a colocar um novo Ponto de Entrada (In Point) 
ou um novo Ponto de saída, ou ambos. Um ponto de entrada é o 
primeiro quadro onde começa o trecho; um ponto de saída é o último 
quadro do trecho. Vamos mudar  o ponto de saída do trecho Boys.mov. 
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Os botões de controlo contêm um cursor de vaivém (shutle slider) , que permite 
avançar ou reverter um trecho manualmente e identificar com precisão os eventos 
para marcação. 

6- Na parte inferior da vista fonte da janela do Monitor, manipule o 
cursor de vaivém até visualizar o primeiro ciclista no fim do seu 
percurso. O tempo que o cursor de vaivém deve ler é  4:20 segundos. 

7-  Clique no botão Mark Out  para definir o ponto de saída. 
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Depois de definir o ponto de saída correctamente, tem que aplicar a mudança ao 
trecho na Linha de tempo. O botão Apply está localizado acima da imagem do 
trecho na vista fonte da janela do Monitor. Este botão aparece sempre que se 
marque um novo ponto de entrada ou de saída num trecho da Linha de tempo. 
 
 

8- Clique no botão Apply para efectivar a marcação. 
 
O Premiere remove o fim do trecho dando-lhe um novo ponto de saída. É  
importante compreender que a área removida não é apagada. O Premiere  esconde 
simplesmente os quadros removidos de forma a não aparecerem na visualização 
prévia ou exportação do programa vídeo. Pode-se restaurar facilmente os quadros 
removidos, apagando o ponto de saída.  
 
A janela da Linha de tempo inclui uma barra de ferramentas  com várias 
ferramentas para fazer ajustes aos trechos. Vamos familiarizar-nos com algumas 
delas. Observe que há um pequeno triângulo negro em alguns  ícones  para indicar 
que há  múltiplas  ferramentas. 
 
Como estabelecemos um novo ponto de saída, há agora um buraco na Linha de 
tempo entre o primeiro e o segundo trecho. Para preservar um fluxo contínuo de 
um trecho para outro temos que mover os outros trechos para a esquerda.  Para 
fazê-lo seleccionamos a ferramenta de selecção de pista aninhado no segundo 
ícone  a contar da esquerda na primeira linha  da barra de ferramentas da Linha de 
Tempo. 
 

9- Na janela da Linha de Tempo, clique e sustenha o ícone de selecção de 
gama, depois o ícone de selecção de pista (track select) para 
seleccionar todos os trechos à direita  de onde fez o clique. Há uma 
maneira de eliminar automaticamente buracos que vamos depois 
aprender. 

 

 
 
10- Clique no trecho Cyclers.mov na pista 1. Este trecho e todos à sua 

direita ficam seleccionados. 
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11- Arraste a selecção para a esquerda até ficar encostada no fim do trecho 
Boys.mov 

12- Clique na ferramenta de selecção (selection tool), porque já está feito o 
queríamos. 

13- Vamos carregar no botão Play da vista do programa da janela do 
Monitor, para um visualização prévia das mudanças feitas. 

14- Guarde  o projecto.  
 
   
 
K. Adição de Áudio 
 
Vamos agora adicionar alguma música ao nosso projecto, importando e colocando 
um ficheiro áudio  na primeira pista de áudio. A música do ficheiro áudio foi 
gravada em estúdio, convertida para o formato digital  e colocada disponível no 
Premiere 6.0. 
  

1 Escolha  File->Import->File e clique duas vezes no ficheiro Music.aif. O 
ficheiro aparece na janela do Projecto. 

2 Arraste o ficheiro Music.aif da janela de Projecto para a pista Áudio 1 da 
janela da Linha de tempo. 

3 Clique no triângulo imediatamente à esquerda da pista 1 de Áudio 1 para 
expandir a nossa vista da pista áudio. 

 

 
 
 A vista expandida mostra a forma de onda do trecho de música. A forma de 
onda mostra a variação do  volume de áudio através do tempo. Picos da forma 
de onda indicam maior volume.  Na secção seguinte, vamos ver como 
sincronizar eventos no vídeo com a música. Por ora vamos bloquear a pista 
para não ser reposicionada mais tarde. 
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4 Clique na pequena caixa do ícone à frente do microfone para bloquear a 
pista áudio. Um ícone preto de bloqueio aparece à frente do cursor sempre 
que o posicionarmos numa pista bloqueada. 

5 Clique na barra de título da janela do Monitor(Program View ) e no botão 
de Play para  uma audiovisualização prévia do vídeo e áudio em conjunto. 

Como deve saber, o Premiere 6.0 disponibiliza um misturador áudio (Audio 
Mixer) sofisticado que permite ajustar pistas de áudio múltiplas ao mesmo 
tempo que se pode ouvi-las com o vídeo em tempo real. Vamos aprender mais 
sobre a mistura de som posteriormente.  

 
 
L. Trechos Vídeo Editados na Janela da Linha de Tempo 
 
Para além da edição de trechos na janela do Monitor, é possível editar trechos na 
Janela da Linha de Tempo (Timeline) usando um variado  número de métodos. 
Para editar com maior precisão na janela Timeline, é muitas vezes mais simples 
visualizar um número maior de quadros. 
 

1 Agora, vamos ajustar  o trecho editado a partir de Boys.mov  de forma 
que o seu ponto de saída esteja sincronizado com o primeiro nível de 
amplitude máximo na pista áudio.Na barra de ferramentas da Linha de 
Tempo clique e  aguente a ferramenta de edição rolante e clique na  
ferramenta de edição de ondas (ripple) aí aninhada. 

 

 
 
 
A ferramenta de edição de ondas permite  compor o trecho especificado 
mas mantém a duração os restantes trechos mudando a duração do 
programa. Para editar o ponto de entrada (IN), arraste a extremidade à 
esquerda do trecho. Para editar o ponto de saída, arraste o extremo direito 
do trecho. O trecho ondula ao longo do projecto e a duração global do 
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programa é encurtada ou alongada conforme o número de quadros 
adicionados ou removidos. Portanto a duração do programa vídeo muda.  

 
2 Posicione a ferramenta de edição de ondas no ponto de saída  do trecho 

Boys.mov e arraste-o até estar alinhado com o nível de amplitude 
maior da forma de onda de Music.aif. A duração do  programa  é 
aumentada ou encurtada para compensar a sua edição mas a duração 
dos trechos adjacentes mantém-se inalterada. Pode ter dificuldades 
aqui. Uma sugestão é diminuir o trecho Boys.mov até o fim da corrida 
de bicleta do primeiro rapaz e depois encurtar o áudio de forma ao pico 
concida com o fim da corrida do rapaz no Boys.mov. 

 
Vamos agora ajustar o trecho Cyclers.mov de tal forma que o seu ponto de saída 
corresponda a um ponto bem definido na linha de tempo. Para conseguirmos isso 
mas usar a paleta de Info. 

1. Clique na ferramenta de selecção da janela da Linha de Tempo  
2. Escolha Window->Show Info e seleccione o trecho Cyclers.mov na 

janela da Linha de Tempo.  
 

 
 

3. A paleta de informações mostra o nome, tipo de trecho, duração e o 
tempo de início e fim do trecho seleccionado. Para além disso, indica a 
posição actual do cursor. Vamos usar a informação do cursor para a 
nossa composição.  

4. Seleccionemos a ferramenta de edição de onda novamente  movendo o 
cursor através da linha onde os trechos Cyclers.mov e Fastslow.mov se 
juntam. (Dependendo do nosso monitor, podemos precisar de ajustar a 
vista do Timeline para o visualizar claramente). 

5. Arrastar a ferramenta de edição de ondas para a esquerda até a posição 
do cursor na paleta de Info ler 0.00:08.01 e então largar o botão do 
rato. 
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Compusemos o ponto de saída do trecho Cyclers.mov. Como a 
composição do trecho foi feita usando o editor de ondas, os trechos 
subsequentes seguiram o processo andando para a esquerda.  

 
6. Seleccione a ferramenta de selecção agora, porque usamos a 

ferramenta de edição de ondas.  
Agora vai-se colocar transições entre trechos.  
 
 
M. Adição de Transições  
 
Uma transição é uma mudança de uma cena para outra, ou de um trecho para 
outro.  A transição mais simples é a supressão onde o último quadro de um trecho 
conduz directamente ao primeiro quadro do seguinte. Colocando os primeiros 
trechos juntos (Boys.mov e Cyclers.mov) criámos uma supressão entre eles. 
 
O Premiere inclui acima de 75 transições, que podem ser seleccionadas duma 
paleta de transições. Para ajudar, pode-se animar as transições e ver a breve 
descrição sobre as transições disponíveis. Para além disso, podemos visualizar 
previamente o efeito da transição com os quadros dos dois trechos envolvidos. 
 
O Premiere dispõe de transições especiais  como o dissolve, limpeza(wipe) e 
zoom  para colocar efeitos especiais na passagem duma cena para outra  para 
permitir adicionar estrutura, nuance ou prender a atenção . Vamos usar a 
dissolução  cruzada (cross dissolve). 
 

1. Se a paleta de transições não estiver aberta, escolha Window-> 
Show Transitions. 
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Aparece  a paleta de transições mostrando as transições disponíveis , organizadas 
por tipos em pastas. Quando se abre uma pasta, vê-se a representação gráfica do 
ícone que ilustra o feito da transição. Se necessário modifique o tamanho da paleta 
por arrasto do seu canto inferior direito.  
 
Para ajudar a escolha entre as várias transições disponíveis, pode animar os seus 
ícones e ler as  respectivas  descrições sumárias.  
 

2. Clique duas vezes na pasta de movimentos 3D (3D Motion) para 
ver as transições disponíveis. Pode ser necessário aumentar a área 
para visualizar as transições com clareza.  
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3. A seguir clique e sustenha a pequena seta negra (►) no canto 

superior direito da paleta de transições e escolha a opção de 
animação (Animate) do menu, para activar a animação dos ícones. 

 
Posteriormente vai verificar que essa opção activa é uma fonte de distracção e 
perda de tempo e vai desactivá-la.  
 

4. Clique na paleta de Info se não estiver activa. 
5. Abra a pasta Dissolve na paleta de transições e seleccione a 

transição de Dissolução Cruzada (Cross Dissolve). A descrição 
desta transição aparece na paleta de informação para lém do seu 
ícone animado. Esta transição é frequentemente utilizada em vídeo 
e filmes; dissolve uma cena na seguinte, com uma duração breve.  
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6. Arraste a transição Cross Dissolve para a janela da Linha do 
Tempo colocando-a entre os trechos Cyclers.mov e Fastslow.mov.  

7.  

 
 
8. Se a caixa de diálogo para configurar transições aparecer  clique 

OK. Vamos aprender mais sobre transições mais tarde. 
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 A transição Cross Dissolve vai aparecer agora na janela da Linha do Tempo na pista 
de Vídeo 1 , sobreposta no ponto de transição entre os dois trechos vídeo. 

 
 

 
 
 
N. Visualização prévia das transições e outros efeitos 

 
O botão de play da vista do Programa permite a visualização prévia de trechos vídeo 
na pista 1 do Vídeo e os trechos áudio mas não as transições, efeitos ou trechos 
sobrepostos  (alguns dos quais na pista Vídeo 2 ou superiores) a menos que tenha sido 
criado  um ficheiro de visualização prévia  (preview file).  Uma vez criado este 
ficheiro de visualização prévia, a vista do Programa (Program View) mostra os efeitos 
adicionais. 
A barra da área de trabalho (barra amarela no topo da timeline)  especifica a porção 
do projecto (com transição e outros efeitos) que se deseja visualizar previamente ou 
colocar na saída. Nesse caso, desejar-se-á  visualizar previamente os três primeiros 
trechos do projecto, incluindo o efeito de dissolução cruzada acrescentado. 
Para visualizar previamente a transição pode-se tanto construir uma visualização 
prévia  da secção do projecto que contém a transição ou fazer uma apresentação que a 
contenha (render-scrub). O render-scrubbing é uma forma rápida de visualizar 
transições que ao contrário da  visualização prévia não pode  ser reproduzido porque 
não são gravadas.   

1. Para fazer o render-scrub da transição: Posicione o cursor na janela da 
Timeline e a seguir arraste o cursor na régua de tempo para além da 
transição e pressione a tecla ALT e, quando  o cursor tomar a forma 
duma seta para baixo (↓), mova o cursor na régua do tempo da janela 
da Linha do Tempo. 

Embora se obtenha desta forma um método expedito para visualização prévia do 
programa de vídeo, não nos dá uma taxa precisa de quadros uma vez que se 
movimentou à mão. Para se visualizar os efeitos a uma dada taxa de quadros é 
necessário gerar um ficheiro de visualização prévia.  
Antes de gerar um ficheiro de visualização prévia, é necessário ajustar a  barra da área 
de trabalho- a barra amarela na secção mais em cima da janela da Linha de Tempo 
para varrer a área que quer visualizar. 

2. Para consegui-lo, posicione o cursor na barra amarela  da área de 
trabalho da janela da Linha de Tempo e ajuste os pontos finais de 
modo à área de trabalho cobrir a transição e tecle Enter. 
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Alternativamente pode usar Timeline->Preview para construir uma visualização 
prévia da transição que pode ser guardada e reproduzida posteriormente.  
 

3. O trecho Cyclers.mov dissolve-se no trecho Fastslow.mov, com a 
duração de um segundo como se pode ser na visualização prévia. 

4. Para visualizar os três trechos completamente  escolha 1 segundo no 
menu da  zona de tempo (Time Zone)  no canto inferior esquerdo da 
Janela da Linha de Tempo. A partir daí é simples estender a área de 
trabalho para o tamanho correcto.  

 
Observação: dependendo do tamanho e da resolução do monitor do nosso computador  
a colocação de 1 segundo feita anteriormente pode não tornar os primeiros três 
trechos completamente visíveis. Se for essa a situação escolha outro parâmetro de 
configuração no menu Time Zone. Fazê-lo não afecta a possibilidade de seguir os 
procedimentos seguintes neste trabalho embora as ilustrações no seu ecrã não sejam 
exactamente iguais às apresentadas neste documento. 
 

5. Arraste o lado direito da sua área de trabalho para estender o seu 
comprimento de forma a alinhá-lo com o fim do trecho Fastlow.mov. 
Observe que a linha de estado  de visualização prévia muda de cor de 
vermelho para verde na Linha de Tempo quando a visualização prévia 
tiver sido feita para um segmento que necessita de apresentação.  

6. Na janela da Linha de Tempo escolha Timeline->Preview ou tecle 
Enter para a visualização prévia.  

Observação: O Premiere mostra uma caixa de diálogo de estado conforme gera a 
janela de previsão. Quando completa a geração do ficheiro, corre a visualização 
prévia na janela do Monitor. 

7. Como a visualização prévia foi guardada, tecle simplesmente Enter 
para repetir a visualização.  

 
O. Divisão dum  Trecho Vídeo 

 
Algumas vezes pode pretender sobrepor apenas uma porção do trecho. Para consegui-
lo, precisa de dividi-lo para criar uma instância nova do trecho original. Podemos 
dividir um trecho na Linha de Tempo recorrendo à ferramenta  de corte (razor). Esta 
técnica é necessária quando se pretendem aplicar efeitos que não podem ser 
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simultaneamente aplicados a um único trecho, como por exemplo uma taxa de 
quadros diferente . 
Vamos dividir o trecho Fastslow.mov de tal forma que se possa mudar a velocidade a 
uma das partes e  diminuí-la progressivamente6. 

1. Na janela da Linha de Tempo mova a linha de edição através do trecho 
Fastslow.mov até ver um plano do circuito sem ninguém (cerca de 2 
segundos do trecho). Deixe a linha de edição posicionada nesse ponto. 

 

 
 
 
2. Na janela da Linha de Tempo, seleccione a ferramenta de corte. 
3. Posicione o cursor sobre o trecho Fastslow.mov na actual linha de 

edição e carregue no rato para dividir.   
O Premiere divide o trecho Fastslow.mov em dois de acordo com o ponto de divisão 
escolhido.  
 

P. Mudança de velocidade dum  Trecho Vídeo 
 
Pode-se mudar a velocidade de reprodução dum trecho para torná-lo mais lento ou 
mais rápido. Mudar a velocidade muda a sua duração sem remover ou adicionar 
quadros.   
A velocidade dum trecho é a velocidade de reprodução quando comparada com a 
velocidade em que foi gravada. A duração dum trecho áudio ou vídeo é o período de 
tempo em que corre – a diferença entre o ponto de entrada e saída do trecho. 
Para tornar a sequência do ciclista mais interessante e objecto da atenção  vamos 
diminuir a velocidade da segunda porção do trecho acabado de dividir, aumentando a 
duração. Isto requer uma pista de sobreposição, onde vamos colocá-lo agora.  

1. Clique na ferramenta de selecção e arraste-a para a segunda porção do 
trecho Fastslow.mov e arraste-a para a pista Vídeo 2.  

 

                                                                 
6 Fade Out 
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Assegure-se que mantém como  posição do trecho exactamente o mesmo ponto no 
tempo alinhando os limites do trecho no mesmo ponto em que estava na pista de 
vídeo1.Vai-se agora mudar a velocidade do trecho. 
 

2. Seleccionar o trecho que acabou de mudar (se já não o estiver) e 
escolha Clip->Speed. 

3. Na caixa de diálogo coloque o valor 30 para New Rate e clique OK. 
A velocidade de reprodução do trecho é agora  30% da velocidade original. Assim a 
duração do trecho aproximadamente triplica.  
 
Para mudar a velocidade visualmente pode seleccionar a ferramenta de esticar a 
velocidade e arrastá-la para o fim do trecho. Esta ferramenta está disponível na barra 
de ferramentas da janela da Linha de Tempo. 
 
A porção do trecho Fastslow.mov com que estivemos agora a trabalhar agora 
sobrepõe-se com uma parte do trecho Finale.mov. Como pretende o clip que foi 
tornado mais lento se extinga para negro, é necessário mover o trecho Finale.mov 
para a direita. 
 

 
 

4. Use a ferramenta de selecção para arrastar o trecho Finale.mov  para a 
direita até que o seu limite do lado direito esteja alinhado com o ponto 
de saída do trecho Music.aif  na pista de áudio 1. 
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Vamos gerar agora uma nova pré visualização. 
5. Usando a barra de selecção mova o ponto de saída do Fastslow.mov  já 

editado na pista de vídeo 2 de forma a coincidir com o  ponto de 
entrada do trecho Finale.mov 

6. Arraste o  fim do lado direito da área de trabalho de forma a cobrir o 
trecho Fastslow.mov na pista 2.  

7. Escolha Timeline ->Preview  ou carregue Enter no teclado. 
8. Guarde o projecto. 

 
 
 

Q. Mudança da opacidade dum  Trecho Vídeo 
 
Se um trecho estiver na pista de vídeo 2  ou superior, pode torná-lo parcialmente 
transparente mudando a sua opacidade.  A opção de opacidade permite extinguir 
ou reforçar um trecho, ou sobrepor  uns trechos por cima dos outros para serem 
visíveis vários ao mesmo tempo.  
 
Veremos mais tarde como sobrepor trechos vídeo. Para já, vamos usar a pista de 
sobreposição  para ajustar manualmente a opacidade dum trecho para conseguir a 
sua extinção. 
 

 
 
Por defeito o Premiere inclui uma pista de sobreposição, a pista 2 de vídeo, acima 
da pista 1. Pode-se adicionar mais pistas, se for necessário. Uma vez colocado um 
trecho vídeo na pista 2, fica disponível uma barra de controlo de opacidade ou 
uma fita de borracha ( rubberband).  Para ver a barra, é necessário expandir a 
pista 2 de vídeo. Adicionando manípulos podemos ajustar a opacidade dum 
trecho. 
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1. Clique na seta na parte esquerda da etiqueta da pista de vídeo 2 . A 
barra da opacidade mostra a opacidade do trecho. Por defeito está 
colocada a 100%. 

2. Se a fita de borracha vermelha que mostra a opacidade não estiver 
ainda seleccionada, clique no  respectivo ícone  para mostrá-la, por 
baixo da pista de vídeo 2.  

3. Com a ferramenta de selecção seleccionada, mova o cursor na 
barra de opacidade (agora o cursor muda para um dedo a apontar) e 
clique mais ou menos a ¾ do trecho para criar uma pequena caixa 
vermelha  chamada manípulo. 

O manípulo divide a barra de controlo em secções que pode ajustar por 
arrastamento. Uma barra de controlo inclui um manipulo e cada extremo para 
definir o começo e o fim da parametrização da opacidade. 

4. Na pista de Vídeo 2 da janela da Linha de Tempo, clique no 
manípulo mais à direita. Mantenha o botão do rato pressionado 
durante o próximo passo.  

5. Carregue na tecla de Shift com o manípulo  seleccionado e arraste 
o manípulo de opacidade até o valor por baixo  do manípulo 
mostrar 20%.  

 

 
 
Carregando na tecla shift antes ou depois de seleccionar o manípulo permite 
visualizar a mudança de valor incremental.  
Isto cria um inclinação para baixo na barra de controlo, que começa no primeiro 
manípulo criado. A inclinação para baixo indica uma diminuição de opacidade. 
Neste caso, a opacidade do trecho começa a 100% e diminui até 20%. 
 
Pode-se também arrastar os manípulos sem carregar na tecla de shift, mas isto 
limita a incrementos de 5% e não produz uma caixa de visualização. Pode 
alternativamente usar a paleta de informação para ver a opacidade definida se não 
carregar na tecla de shift. 
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6. Visualize previamente o que foi feito.  
Carregue na tecla Alt e arraste devagar na régua de tempo acima do trecho que foi 
ajustado. A visualização prévia corre na janela do Monitor. Como o trecho é o 
único na Linha de tempo, extingui-se na cor do fundo que é negra. 

7. Guarde o projecto. 
 
 
R. Adição de Efeitos Especiais a um  Trecho Vídeo 
 

    O Premiere permite-nos criar muitos tipos de efeitos especiais.  Quando se aplica 
um efeito, chamado muitas vezes filtro, a um trecho, o efeito fica listado na paleta de 
controlo de efeitos. Os trechos que têm efeitos aplicados  aparecem na janela da linha 
de tempo com uma borda de ciano no topo. 
 
Cada efeito tem um um quadro chave por defeito no início e fim do trecho, indicando 
por meio losângulo na linha de quadros chave na janela da Linha de Tempo. Os 
efeitos são listados  directamente acima da linha de quadros chave do trecho. Se um 
efeito tem controlos ajustáveis, podemos mudar o tempo de início ou de fim do efeito 
oua dicionar quadros chave adicionais  para criar um efeito de animação. Se não se 
fizer nenhuma mudança nos quadros chave por defeito, os parâmetros associados ao 
efeito são aplicados ao trecho inteiro. 
 
Se um trecho tem múltiplos efeitos aplicados, o menu da lista de efeitos apresenta-os 
por ordem em que são apresentados, do topo para baixo. Podemos mudar a ordem da 
lista e desta forma a ordem em que são apresentados.  
Para o último trecho do programa vídeo, vamos adicionar o efeito de desfocagem da 
câmara de filmar, que desfoca o trecho como se estivesse a abandonar a gama de 
focagem da câmara de filmar. Configurando quadros chaves para a desfocagem, pode 
simular um objecto ou sujeito  a entrar e a sair da gama de focagem. 
 

1. Seleccione o trecho Finale.mov na janela da linha de tempo. 
2. Escolha Window-> Show Video Effets. Clique duas vezes na pasta 

Blur. O efeito Camara Blur é listado conjuntamente com outros efeitos. 
3. Arraste o efeito Camara Blur para o trecho Finale.mov na janela da 

Linha de tempo. 
O efeito aparece na janela da Linha de Tempo e na paleta de controlo de efeitos. 
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4. Na paleta de controlo de efeitos clique em Setup à direita do nome do 
efeito.  A caixa de diálogo da configuração do efeito Camara Blur 
aparece. Arraste a barra do cursor para zero e clique OK. Os 
parâmetros escolhidos aplicam-se ao  trecho inteiro (se não fizer 
mudanças em algum quadro chave). 

 

 
 
Para criar um efeito de mudar a focagem, tem que se variar o efeito Camara Blur 
através do tempo. Para fazê-lo active keyframes (quadros chave). Um quadro chave  
especifica um valor de controlo num instante de tempo específico. 
 
Como se pretende que a desfocagem comece  a meio do trecho Finale.mov , vai-se 
mover o primeiro quadro chave. Mover o quadro chave  limpa (scrubs)  o trecho na 
visão de Programa da janela do monitor. 
 

5. Na janela da Linha de Tempo clique no triângulo na parte esquerda da 
etiqueta da pista de vídeo 1 para mostrar a linha de quadros chave. Esta 
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aparece debaixo da do trecho da Janela de Tempo depois de ter 
adicionado o efeito ao trecho. Os quadros chave são pequenos 
rectângulos brancos aparecendo nos extremos na linha dos quadros 
chave. 

 

 
 
6. Crie um quadro chave colocando a linha de edição a meio do trecho 

Finale-mov, seleccione o trecho a seguir e clique na caixa de 
navegação entre as duas setas. Aparece uma marca de verificação na 
caixa. 

 
 
 

Com o novo quadro chave criado vai-se aumentar o nível  de desfocagem.  
7. Na paleta de controlo de efeitos, clique em Setup para aceder à caixa 

de diálogo ou ajustar directamente o efeito movendo o cursor. Arraste 
o cursor até o Camara Blur estar a 80% e depois clique em Ok. 

Uma vez que nem todos os efeitos têm uma janela de configuração, o método usado 
para mudar um feito varia dependendo do efeito.  

8. Arraste o quadro chave que acabou de criar até que o código de tempo 
da vista do Programa da janela do Monitor apresente  00:00:25:00 (25 
segundos). 

9. Agora seleccione o último quadro chave e uma vez mais arraste o 
cursor na barra de controlo de feitos até que o Blur esteja a 80%. 
Clique Ok.  

Vamos rever rapidamente o que se fez. Configurando três quadros chave, o primeiro  
a 0%, o segundo e o terceiro a 80%, especificou-se que o efeito de desfocagem 
começa a 0% no instante de tempo especificado, aumenta de 0% a 80% até aos 25 
segundos e mantêm-se a 80% até o fim do trecho.  
 
Porque não usar apenas dois quadros chave: o primeiro a 0% e o segundo a 80%? O 
Premiere cria sempre uma variação linear entre quadros chave.  Assim, se se usar dois 
quadros a desfocagem varia linearmente deste o início ao fim do trecho. Não é o 
efeito desejado. Pretende-se que ocorra rapidamente e depois se mantenha nesse nível 
até ao fim do trecho. 
 
Vamos visualizar previamente o trabalho realizado novamente. 

10. Arraste o extremo direito da área de trabalho até que ultrapasse o fim 
do trecho Finale.mov. 

11. Escolha Timeline ->Preview  ou tecle Enter. 
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12. Guarde o Projecto. 
 

S. Sobreposição duma imagem  
 
O Premiere disponibiliza quinze chaves (métodos para criar transparência) que 
podem ser aplicadas a um trecho para criar transparência. Podem-se usar chaves 
baseadas na cor para sobrepor,  chaves baseadas no brilho para adicionar textura 
ou efeitos especiais, chaves de canais alfa para para trechos ou imagens que já 
contêm um canal alfa, e chaves de metal para adicionar chaves para percurso ou 
sobreposições criativas. 
 
Na secção anterior, usamos o efeito Camera Blur para para desfocar a segunda 
metade do trecho final. Vamos agora sobrepor um logotipo  de empresa no topo 
deste trecho, para parecer que a câmara de filmar está agora a focar o logotipo. 
 

1. Escolha File->Import->File. Localize e seleccione o ficheiro 
Veloman.eps na pasta do Tour  e clique em Open. 

 
2. Posicione a linha de edição na janela da Linha de Tempo na 

posição correspondente a 00:25:00 (25 segundos). 
 

3. A partir da janela de Projecto arraste a   imagem Veloman.eps para 
a pista 2 de Vídeo da janela da Linha de Tempo  de tal forma que o 
seu limite esquerdo esteja alinhado com a linha de edição 
(mostrada na paleta Info como “Starting at 00:25:00”). 

 

 
 
Por defeito, a duração duma imagem fixa é colocada nas preferências genéricas 
como 30 quadros. Como a taxa de quadros neste projecto é colocada a 15 quadros 
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por segundo a duração da imagem é de 2 segundos. Para manter a imagem visível 
até ao fim do programa de vídeo é necessário aumentar a sua duração. A duração 
duma imagem fixa pode ser especificada esticando a sua representação na linha de 
tempo. 
 

4. Na janela da Linha de Tempo, seleccione a ferramenta de selecção 
e arraste o limite direito da imagem Veloman.eps para a direita até 
estar alinhada com final do trecho Finale.mov 

A imagem agora sobrepõe-se com o trecho Finale.mov da janela da Linha de 
Tempo. A área de sobreposição é onde o logotipo será sobreposto à corrida de 
bicicleta. 
 
Mantenha pressionada a tecla Alt. e arraste na régua do tempo na área em que os 
dois trechos se sobrepõem.  
 
Tudo o que se vê é a imagem, não se vê nada do trecho vídeo. Isto é porque a 
imagem Veloman.eps é completamente opaca. Vamos agora tornar o fundo da 
imagem transparente.  
Para especificar que certas áreas do trecho  fiquem transparentes e outras opacas 
precisamos de usar uma chave de transparência. Essa chave torna cores 
designadas transparentes ou semi transparentes.  Uma chave  azul torna o azul 
transparente. Desta forma uma actor pode ser filmado no estúdio com um fundo 
azul e depois ser sobreposto uma cena de rua.  Criar transparência com uma cor é 
designado como desfixar determinada cor. Para sobrepor a imagem Veloman.eps 
precisamos de desfixar o branco de fundo. 

5. Seleccione a imagem Veloman.eps na janela da Linha de Tempo. A 
seguir, na paleta de controlo de efeitos, clique em Setup para 
transferência.  
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A caixa de diálogo para a transparência mostra o trecho seleccionado numa área 
de amostra. De acordo com a chave que se  escolhe  é aplicado o nível de 
tarnsparência  ao trecho e o resultado é mostrado na área de amostra. 
 

6. Na caixa de diálogo de configuração da transparência, escolha 
White Aplha Matte na janela do tipo de chave. Esta chave desfixa 
qualquer área de alfa branco que contenha um canal alfa. 

7. Clique em OK para aplicar a configuração ao trecho. 
8. Para previsualizar  o efeito,  mantenha pressionada a tecla Alt e 

arraste a régua do tempo na área em que a sobreposição ocorre. 
9. Guarde o projecto. 

 
 
 
 
T. Animação dum  Trecho Vídeo com quadros chave  

 
É fácil mudar um efeito através do tempo com auxílio de quadros chave. Depois de 
aplicar um efeito a um trecho vídeo no Premiere, pode começar e terminar o efeito em 
diferentes instantes de tempo ou pode mudar os seus parâmetros através do tempo 
para aumentar o respectivo impacto. Neste exemplo, vai-se aumentar o interesse da 
imagem Veloman.eps. Vamos fazê-la fazer zoom no quadro a partir da esquerda. 
 

1. Se a imagem Veloman.eps não estiver ainda seleccionada, seleccione-a na 
janela da Linha de Tempo. 

2. Na paleta de controlo de efeitos, clique em Setup na direita do efeito 
movimento para abrir a caixa  de diálogo. 
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No topo do  lado esquerdo da caixa de diálogo aparece uma amostra do trecho 
seleccionado a mover-se ao longo do percurso para o movimento por defeito. A parte 
direita da caixa de diálogo mostra o percurso com quadros chave no início e no fim. 
Observe que o percurso por defeito coloca  os quadros chave de início e de fim fora 
da área visível do programa vídeo de tal forma que o trecho entra na área vísível da 
esquerda, move-se através dela e sai pela direita. 
Para movimento simples vertical, horizontal ou diagonal, pode arrastar os quadros 
chave de ínicio e de fim para qualquer localização dentro ou fora da área visível. 
Conforme se faz isto, o cursor transforma-se num dedo a apontar. Pode-se clicar para 
adiconar um quadro chave, arrastá-lo para a localização desejada, criando um novo 
segmento no percurso.  
 

3. Continuando o trabalho na área do percurso de movimento, arraste o quadro 
chave de início de tal forma que aproximadamente metade da imagem se 
sobreponha com  a área visível. Pode-se também especificar a posição da 
imagem com coordenadas. É o que se vai fazer a seguir.   

 

 
 
 

4. Clicar no quadro chave final e colocar as coordenadas (26,-8). O ponto de fim 
move-se para a localização especificada. 

 
Por defeito, a  área de  percurso de movimento disponibiliza dois pontos, o de ínicio e 
o de fim. Foi deste último que acabamos de modificar a posição. Pode-se também 
especificar o zooming, rotação e distorção nesses pontos e pode-se ainda acrescentar 
novos pontos , cada um dos quais com valores de movimento particulares. 
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No sentido de manipular a imagem Veloman.eps numa forma visível para o  olho 
humano, vamos adicionar um novo ponto de movimento. E  especificar novos valores 
de zoom , rotação e distorção o fim de ínicio e de fim e finalmente aplicar uma 
rotação de tal forma que o logotipo rode quando  parece retroceder na distância. 

 
 

 
 

 
 
 

5. No percurso do movimento seleccione em qualquer ponto e clique para criar 
um novo quadro chave para um ponto de movimento. 

 
6. Mova o ponto mais para baixo e para a direita de acordo com a figura acima 

 
7. Seleccione o ponto de início e coloque o Zoom a 0  
8. Seleccione o ponto de fim coloque o Zoom a 0  
9. Coloque a rotação a  720 (2*360) em graus. 
10. Clique OK para a caixa de diálogo. 
11. Vamos fazer uma visualização prévia. Com Timeline->Preview. Isto depois de 

mover a barra da área de trabalho para cobrir a imagem. 
 

U. Exportação do Filme 
 
Para completar  vamos converter o nosso projecto num filme Quicktime. O 
formato Quicktime é um formato normalizado tanto para o sistema operativo 
Windows como Mac. Quando se exporta para um filme (File->Export Timeline-> 
Movie), o  Premiere usa parâmetros nas caixas de diálogo para configuração da  
exportação. 
 

1. Active a janela da Linha de Tempo 
2. Escolha File -> Export Timeline -> Movie 
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3. Pressione o botão de Settings 
Assegure-se que a escolha para o tipo de ficheiro é QuickTime, e que é 
seleccionado todo projecto para o Range. 
Assegure-se também que as opções Export Video e Export Audio estão 
seleccionadas. Os valores por defeito para os outros parâmetros, incluindo a 
compressão, são adequados para este projecto. 

4. Pressione Next. Mude o tamanho do quadro para 240x180 e clique 
em OK. 

 
 

 
 
 

5. Na caixa de diálogo Export Movie, especifique um nome de 
ficheiro  (não se esqueça da extensão .mov no fim) uma pasta para 
colocar o filme e clique Save. 

 

 
 
O Premiere começa a fazer o filme, e vai mostrando uma barra de estado com a 
estimativa da quantidade de tempo necessária para mostrar ou enviar para a saída 
o filme.  
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O tempo para produzir a saída depende das capacidades do nosso computador. Na 
maioria dos sistemas o Premiere demora menos de 7 minutos. Pode-se cancelar o 
processo a qualquer instante carregando na tecla Esc.  
 
Quando o filme estiver completo, abre a sua própria janela. 
 

6. Clique no botão de Play para ver.  
 

 
 

 
7. Se não  gostar do que viu, veja o seu produto no QuickTime Player. 
8. Publique o filme na sua área WWW, depois de o ter compactado 

previamente. 
 

V. Vídeo entrelaçado e não entrelaçado 
 

O Vídeo Digital ou Analógico pode ser classificado como entrelaçado e não 
entrelaçado (varrimento progressivo). Os programas de vídeo que usem as normas 
NSTC, PAL ou SECAM são entrelaçados. Cada quadro consiste de dois campos 
mostrados em duas passagens. A maior parte dos ecrãs de PCs usam o varrimento 
progressivo, no qual todas as linhas do quadro são mostrados sequencialmente numa 
única passagem do topo à base do ecrã antes de aparecer o próximo quadro. 
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Figura 1: Varrimento entrelaçado, com campo ímpar e par 

 
No vídeo entrelaçado, um quadro está dividido em dois campos. Uma TV mostra o 
primeiro campo que contém as linhas ímpares  do ecrã e a seguir  o campo seguinte 
que contém as linhas pares. Entre duas linhas do mesmo campo existe o espaço em 
branco para uma linha do outro campo. Os  quadro de vídeo PAL ou SECAM (NSTC)  
são mostrados todos os 1/25  (1/30) segundos  e contêm dois campos entrelaçados 
mostrados todos os 1/50 (1/60)  segundos.  O campo que contém as  linhas ímpares  
de varrimento é chamado o campo ímpar e o outro o campo par. 
 
Qunado manipular ou exportar vídeo entrelaçado assegure-se a ordem dos campos 
especificados estão de acordo com o sistema receptor. Caso contrário, o movimento 
pode aparecer tremido e os contornos dos objectos no quadro podem aparecer 
quebrados.  

 
Figura 2: Varrimento progressivo 

Os sinais de televisão são entrelaçados por causa dos primeiros sistemas de televisão e 
a natureza do sistema de visão humano. Quando é apresentada uma série de quadros, a 
taxa de quadros (intervalo de tempo de quadros) tem que ser suficientemente grande 
para  conseguir a persistência da visão, uma imagem contínua sem tremidos que sejam 
notados. Na Europa usa-se tensão alterna com ciclos de 50 Hz, mas os antigos 
sistemas de TV eram capazes de mostrar apenas 25 quadros por segundo (qps). 
Entrelaçando dois campos a 50 qps consegue-se conciliar a fraca largura de banda 
com o problema da persistência da visão. Actualmente a tecnologia permite taxas de 
quadro mais altas mas o entrelaçamento é preferível para conseguir a persistência da 
visão quando há limitações de largura de banda.  
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Quando os computadores começaram a usar monitores de vídeo, os problemas com o 
fósforo estavam já resolvidos tornando o varrimento progressivo para os monitores de 
computadores. Os filmes são diferentes do vídeo são similares ao varrimento 
progressivo, uma vez que mostram um quadro de cada vez.  
O entrelaçamento é uma característica associada à captura e visualização dos trechos e 
não é uma componente estrutural dos média ou dos formatos de ficheiros. Por 
exemplo é possível reproduzir um filme PAL digitalizado  (entrelaçado) num monitor 
Windows (varrimento progressivo) ou mostrar um filme de  35mm (varrimento 
progressivo) num monitor PAL (entrelaçado). 
O vídeo com varrimento progressivo permite uma qualidade de imagem final superior 
quando se edita com filtros e efeitos que afectam o movimento, incluindo rotações de 
quadros ou compondo vídeo em tempo real com efeitos especiais. Para além disso, 
linhas finas e texto pequeno é mais propício a tremores num ecrã entrelaçado. Para 
diagnosticar problemas relacionados com campos entrelaçados, veja os trechos num 
monitor de TV entrelaçado, porque fazê-lo num monitor de varrimento progressivo 
não é fiável. 
 
Se pretende tornar mais lenta ou suspender um quadro num trecho, deve querer 
desentrelaçar  os seus campos para os tornar quadros completos. No caso oposto, pode 
necessitar de entrelaçar um trecho originado em ambiente de varrimento progressivo 
que quer usar em televisão. 
Para desentrelaçar vídeo use  Editing Video > Editing clips > Freezing a video frame. 
Se quiser mais informação veja o mesmo tópico na ajuda (Help).  
Para entrelaçar veja  Editing Video > Editing clips > Processing interlaced video 
fields. Se quiser mais informação veja o mesmo tópico na ajuda (Help).  
 
. 

 

 
W. Encontrar um CODEC apropriado 
 

 

Os  Codecs são algoritmos de compressão e descompressão que são cruciais para 
produção de áudio e vídeo digital. Alguns Codecs são mais adequados que outros para 
certo tipo de trabalho. Que codecs estão disponíveis quando se edita vídeo digital com 
o Adobe Premiere, depende do sistema operativo e da placa de aquisição de vídeo. 
Para  além disso, essa escolha pode ser  posteriormente restringida pelo modo de 
edição escolhido na caixa de diálogo para definição dos parâmetros do Projecto. Por 
exemplo são diferentes se escolher Video for Windows em alternativa ao QuickTime  
para modo de edição7. Quando exporta vídeo digital, os codecs disponíveis estão 
determinados pelos tipos de ficheiros disponíveis que podemos escolher na caixa de 
diálogo para exportação.  
 
Podemos avaliar os CODECs pelo seu âmbito de uso, métodos de compressão e pela 
forma como manipula os diferentes tipos de imagens e sons.  O software QuickTime e 
Video for Windows são usados em contextos diversificados tal como conferências 
vídeo pelo que incluem uma série de codecs que não são apropriados para edição. Os 
codecs usados para outros propósitos que não são a edição estão identificados nesta 
secção pelo que devem ser evitados.  Se a nossa placa de aquisição de vídeo estiver 

                                                                 
7 Editing Mode 
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bem instalada, o seu codec aparece no menu de Compressão e no painel de 
parametrização de vídeo, na caixa de diálogo de configuração do Projecto. Também 
se tem acesso ao CODEC na caixa de diálogo para nosso hardware de captura vídeo.  
 
Em qualquer lista de codecs, a opção None ou Uncompressed  disponibiliza   imagem 
e som de  boa qualidade porque não é aplicada qualquer compressão. Contudo esta 
opção não é realista nem recomendada porque exige um sistema extremamente rápido 
e grandes quantidades de espaço em disco. Contudo comprimir o áudio é 
normalmente desnecessário. A diferença do tamanho de ficheiro não é muito grande e 
a opção de compressão é  declinada pela perda de qualidade.  
 
Observação:  
 
Os codecs seguintes estão disponíveis na versão de Vídeo para Windows e 
QuickTime na altura em que este guia foi escrito. A lista actual dos codecs varia com 
as actualizações do Vídeo para Windows e do QuickTime. Podem estar disponíveis 
codecs adicionais  dependendo do hardware e software de vídeo e áudio   instalados. 
 
 
 

Codecs  para video  no Vídeo for Windows (só Windows) 
 
Na edição, estão disponíveis os seguintes codecs software se escolher    no menu do 
modo de edição no painel de configuração geral da caixa de diálogo dos parâmetros 
do projecto.  
 

 
 
Quando exportamos, temos os seguintes codecs se escolhermos  no menu de formatos 
de ficheiros nos parâmetros de configuração geral da caixa de diálogo Export Movies 
Settings  o tipo Microsoft AVI. 
 

 
Indeo Vídeo 5.10 
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Útil para vídeo distribuído sobre a Internet para computadores com processadores 
MMX e Pentium II. Este codec inclui funcionalidades como compressão rápida, 
controlo flexível de quadros chave, efeitos de reprodução com afinação da cor8 
(transparência), e cortes em linha que reduzem a carga dos dados. Para além disso, 
este codec usa uma descarga progressiva que se adapta a diferentes larguras de banda.  
O uso complero destas funcionalidades requer a utilização de software utilitário 
separado disponibilizado pela Intel. Está concebido para funcionar em conjunto com o  
software codec para  áudio  da Indeo. 
 
Microsoft RLE 
 
Útil para compactar frames que contêm áreas de cor plana tal como animação de 
cartoons. Este codec usa um compressor   8-bit run encoding (RLE) espacial  e não 
tem perdas se for configurado a 100% de qualidade.  
 
Microsoft Vídeo 1 
 
Útil para compactar  vídeo analógico. Trata-se dum codec espacial com perdas que 
suporta profundidade de 8 e 16 bits. 
 
Indeo Video R3.2 
 
Útil para compactar vídeo de 24 bits para reprodução em CD-ROM. Este codec obtém 
uma maior taxa de compressão, melhor qualidade de imagem e velocidade de 
reprodução mais rápida que o codec Microsoft Vídeo 1. Para melhorar os resultados  
use  fontes em bruto que não tenham sido compactadas previamente por um codec 
com elevadas perdas.  Quando usado com um débito para reprodução este codec 
produz filmes que são comparáveis em qualidade com os compactos pelo codec 
Cinepac.  
 
Cinepack Codec da Radius 
 
Útil para compactar vídeo de 24 bits para CD-ROMs e ficheiros de vídeo para 
descarga via Web. Este codec consegue taxas de compressão mais elevadas e 
velocidades de reprodução mais rápidas que ocodec Vídeo. Pode-se ajustar o débito 
de dados para reprodução; a qualidade das imagens é notoriamente pior a velocidade 
abaixo de 30 KBps. Este codec é assimétrico --- descompactação rápida mas a 
compactação suficientemente lenta para não ser adequada para edição. Para conseguir 
melhores resultados deve ser usado apenas para exportar a versão final do ficheiro de 
vídeo. 
 
 

Codecs áudio do Video for Windows (só Windows) 
 

Quaando se edita ficam disponíveis os seguintes codecs quando se escolhe Video for 
Windows no modo de edição do menu de configuração geral da caixa de diálogo dos 
parâmetros do projecto. 
 

                                                                 
8 chroma keying  
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Quando exporta,   se escolher Microsoft AVI  como tipo de ficheiro  do menu de 
configuração geral da caixa de diálogo dos parâmetros de exportação, tem disponíveis 
os seguintes codecs software. 
 

 
 
 

Pode escolher um codec áudio particular do menu Compressor na configuração dos 
parâmetros áudio da caixa de diálogo da configuração do  Projecto  
 
 

 
 
ou da caixa de diálogo da exportação áudio.  
 

 
 



 52

Genericamente, use um codec especificamente para o tipo de áudio do seu programa 
tal como fala, música ou multimédia. Evite codecs concebidos para telefone a menos 
que o seu áudio seja fala a ser descarregada em linhas de baixa velocidade  via Web. 
 
MPEG Camada 3 
 
Também conhecido como MP3. Trata-se do terceiro esquema para compressão áudio 
MPEG. O MPEG camada 3 usa uma compressão perceptível e psico-acústica para 
remover as partes do sinal áudio que não são perceptíveis ao ouvido humano. Isso 
resulta numa relação de compressão de 12:1 sem perda de qualidade áudio. O MP3 é 
o formato comum para distribuição de ficheiros de música através da Internet. 
. 

 
ACELP.net 
 
Um codec orientado para a rede que usa concatenação de quadros e entrelaçamento 
para melhorar a qualidade áudio.  Permite uma  taxa de transferência de bits dual 
8.5/6.5 kbps ou uma fixa de 5.0 kbps. 
 
WM-Audio 
 
 
Mais conhecido como compressão áudio Microsoft Windows Media. Trata-se da 
norma codec para  Microsoft  Active Streaming Format que combina a codificação 
rápida com boa qualidade para música e  está optimizado para os processadores 
Pentium II (MMX) e III (SSE/SIMD). O WM-Audio tem uma larga de taxa de bits 
desde 5kbps a 128 kbps e oferece uma qualidade de som na Internet mesmo através de 
modems 28.8. É considerado como um futuro substituto do MP3  
 
 
Indeo Audio Software 
 
Útil para distribuição de música e fala através da Internet. Consegue uma relação de 
compressão máxima de 8:1. Este codec foi concebido para funcionar conjuntamente 
com  o codec Indeo Video. 
 
 
Microsoft G.723.1 
 
Um Codec concebido para conferências vídeo. Oferece uma qualidade aceitável para 
voz, mas é uma escolha pobre para música ou efeitos sonoros. A qualidade de áudio é 
mais fraca que outros codecs que usam a mesma largura de banda. 
 
L&H Codecs 
 
Compressão da fala e de música desenvolvida por  Lernout & Hauspie™. 
 
TrueSpeech 
 
Usado para a fala através da Internet a baixas velocidades.  
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Microsoft GSM 6.10 
 
Usado para fala, principalmente telefone na Europa. 
 
Microsoft CCITT G.711 
 
Este codec usa a codificação  µ-Law e é usado para telefone digital na América do 
Norte e Japão 
 

 
MS-ADPCM 
 
Uma concretização da Microsoft para o Adaptative Differencial Pulse Code 
Modulation (ADPCM) um formato de áudio digital comum para armazenar áudio em 
qualidade CD. 
 
Microsoft IMA ADPCM  
 
Uma concretização do ADPCM, útil para áudio em multimédia em ambiente de 
plataformas múltiplas, desenvolvido pela Interactive Multimedia  Assocaition (IMA). 
 
 
 
 
. 

 
 
 
 
Codecs Vídeo  QuickTime  
 
 

Quaando se edita ficam disponíveis os seguintes codecs quando se escolhe 
QuickTime no modo de edição do menu de configuração geral da caixa de diálogo 
dos parâmetros do projecto. 
 

 
 
Quando exporta,   se escolher QuickTime  como tipo de ficheiro  do menu de 
configuração geral da caixa de diálogo dos parâmetros de exportação, tem disponíveis 
os seguintes codecs software. 
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Vídeo Componente 
 
Útil para capturar, arquivar ou armazenar temporariamente vídeo. Tem uma razão de 
compressão relativamente baixa pelo que requer grandes capacidades em disco. 
 

Graphics 
 
Útil para boa qualidade de imagem com cor de 8 bits. Foi concebido primariamente 
para imagens fixas de 8 bits mas é usado também para vídeo. Como este codec não 
consegue relações de compressão altas e apropriado para reprodução de disco mas não 
para CD-ROMs. 
 
Vídeo 
 
Utilizado para capturar e compactar vídeo analógico. Este codec obtém alta qualidade 
de reprodução de disco e qualidade moderada  para reprodução de CD_ROM. Suporta 
compressão espacial e temporal para vídeo de 16 bits.  Os dados podem ser 
recompactados para aumentar a relação de compressão com degradação mínima na 
qualidade. 
 
Animação 
 
Útil para trechos vídeo que usam áreas grandes de cores sólidas tal como animação de 
cartoons. Os parâmetros de configuração determinam se a compressão é com perdas 
sendo a de 100% de qualidade sem perdas.  O codec Animação usa um algoritmo de 
compressão da Apple. Quando usado em compressão sem perdas pode ser útil para 
guardar sequências sem perdas ou outros gráficos em movimento. 
 
Motion JPEG A e B 
 
Útil pra transcodificadores, para transferir ficheiros de vídeo capturados para outros 
computadores equipados com placas de aquisição de vídeo, particularmente em 
plataformas diferentes. Esses codecs são versões do JPEG concretizados em muitas 
placas de aquisição de vídeo. 
Algumas placas de aquisição de vídeo incluem circuitos integrados que aceleram o 
Motion JPEG de forma a ser editado mais rapidamente. Verifique a documentação da 
sua placa de aquisição de vídeo para determinar o grau de suporte a esses codecs. 
 
Photo JPEG 
 
Usado para imagens fixas que contenham mudanças de cor graduais  ou que não 
contenham um alta percentagem de  arestas ou mudanças acentuadas como acontece 
em muitas fotografias. Este codec introduz perdas mas parametrizada com elevada 
qualidade a imagem compactada não é quase igual à original.  É simétrica, isto é 
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tempos de compressão e descompressão similares mas duma ordem de grandeza tal 
que não se adequa a vídeo em tempo real. Não é recomendado para imagens a editar 
posteriormente por causa das suas perdas relativas. Contudo, a sua relação de 
compressão e qualidade de imagens altas podem torná-la apropriada para transferir 
ficheiros entre sistemas ou para arquivar projectos terminados.   
 
H.263 
 
Utilizado para conferência vídeo a baixas velocidades: não recomendado para edição 
genérica de vídeo. 
 
DV-PAL e DV-NSTC 
 
Formatos de vídeo digital usados por hardware PAL e NSTC. Estes codecs permitem 
a transferência de trechos dum gravador ou câmara DV que tenhamos ligado ao nosso 
PC directamente para o Premiere. Também são adequados para transferir  vídeo 
digital entre plataformas diferentes e entre computadores com placas de aquisição de 
vídeo digital isto é como transcodificadores.  
 
Cinepak 
 
Codec usado para compactar vídeo de 24 bits concebido para CD-ROMs ou ficheiros 
de vídeo a descarregar via Web. Este codec atinge maiores relações de compressão e 
velocidades de reprodução que o codec Video. Pode-se parametrizar o débito para a 
reprodução; a qualidade da imagem  perde qualidade de forma visível a débitos de 
dados inferiores a 30 kbps. É um codec assimétrico, isto é  descompacta rapidamente 
mas a compressão é suficientemente lenta para tornar impraticável usálo em 
ambientes de edição.  Para se obter melhores resultados deve ser usado apenas para 
exportar a versão final dum ficheiro vídeo.  
 
 
 
 

 
Sorenson Video  
 
Útil para compactar vídeo de 24 bits concebido para discos CD-ROM ou para 
ficheiros de vídeo acessíveis via Web. Similar ao Cinepak, este novo codec foi 
concebido para se conseguir alta qualidade a débitos  abaixo de 200 Kbps. É capaz de 
melhor qualidade de imagem e ficheiros mais compactos que o Cinepak. Precisa de 
tempos de compressão superiores ao Cinepak, portanto adequados para exportação 
final mas não para edição. Suporta escalabilidade temporal, o que permite um  filme 
exportado para um computador de topo de gama  e ser reproduzido graciosamente 
num computador de baixa gama. 
 
 
Planar RGB  
 
Um codec sem perdas eficaz para quadros que usem áreas grandes com cores sólidas 
tal como uma animação. Usa codificação run-length e é uma alternativa ao codec 
Animation. 
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Codecs áudio QuickTime  
 
Quando se edita, ficam disponíveis os seguintes codecs se se escolhe QuickTime   no 
modo de edição do menu de configuração geral da caixa de diálogo dos parâmetros do 
projecto. 
 

 
 
Quando exporta,   se escolher QuickTime   como tipo de ficheiro  do menu de 
configuração geral da caixa de diálogo dos parâmetros de exportação, tem disponíveis 
os seguintes codecs software. 
 

 
 
 

 
 

 
 
Os codecs áudio aparecem no menu de tipo da configuração áudio ou numa caixa de 
diálogo própria.  Alguns dos codecs usam uma relação de compressão específica (tal 
como 2:1). Nessa situação a relação de compressão aparece depois do nome do codec  
Genericamente, use um codec especificamente para o tipo de áudio do seu programa 
tal como fala, música ou multimédia 
 Evite codecs concebidos para telefone a menos que o seu áudio seja fala a ser 
descarregada em linhas de baixa velocidade  via Web. 
 
µ-Law 2:1 
 
Útil para trocar áudio com aplicações em plataformas (tal como máquinas Unix) onde 
o µ-Law  é um formato áudio normalizado. O codec  µ-Law  é usado para telefone 
digital na América e no Japão. 
 
16-bit Big Endian e16-bit Little Endian 
 
Usado quando o áudio precisa de ser usada a codificação  Big Endian or Little Endian 
(ordem dos bytes) , típica em situações quando se prepara  áudio específico para 
microprocessador. Esses codecs são adequados para engenheiros de hardware ou 
software mas pouco adequados para edição de vídeo. 
 

24-bit Integer and 32-bit Integer 
 



 57

Usado quando se armazena   áudio em 24 bits ou 32 bits  específico para 
microprocessador. Esses codecs são adequados para engenheiros de hardware ou 
software mas pouco adequados para edição de vídeo. 
 
IMA 4:1 
 
Útil para audio multimédia em ambientes multi-plataforma. Foi desenvolvido pelo 
IMA usando o ADPCM. 
 
 
32-bit Floating Point and 64-bit Floating Point 
 
Adequado quando o audio precisa de ser armazenado usando codificação em vírgula 
flutuante com 32 ou 64 bits, como por exemplo em situações em que se prepara áudio 
específico para  microprocessador. Esses codecs são adequados para engenheiros de 
hardware ou software mas pouco adequados para edição de vídeo. 
 
 
ALaw 2:1 
 
Similar ao  µ-Law mas usado principalmente para  telefone digital na Europa.  
 
Qualcomm PureVoice 
 
Concebido para voz, trabalha melhor a 8kHz. Baseado no  Code Division Multiple 
Access (CDMA)  norma tecnológica para telefone celular. 
 
 
QDesign Music Codec 
 
Útil quando se compacta música de alta qualidade para distribuição via Internet. 
Consegue distribuir áudio com qualidade CD (16 bits, 44.1 kHz) sobre uma linha de  
28.8 Kbps . 
 
MACE 3:1 and MACE 6:1 
 
Útil como um codec áudio de propósito geral. O  Macintosh Audio Compression and 
Expansion codec (MACE)  já foi construído há muito o tempo como parte como 
gestor de som do sistema operativo do Mac. O MACE 3:1 tem uma relação de 
compressão mais baixa  e disponibiliza maior qualidade que o ’s MACE 6:1.  Como é 
disponibilizado com o QuickTime 3.0 ou superior também está acessível no Windows 
se for instalado o  QuickTime. 
 

 
X. Bibliografia a  utilizar 

 
Slides apresentados pelo docente nas aulas e acessíveis na página da disciplina. 
Adobe Premiere 6.0, Classroom in a Book, Adobepress, 2001, disponível na 
Biblioteca. 
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Adobe Premiere 6.0 User Guide, Adobe Systems, 2000. A disponibilizar no 
Laboratório do ICS. 
Users Guide Video, Pinnacle Systems DV500Plus, Pinnacle Systems, 2002. A 
disponibilizar no Laboratório do ICS. 
Textos de apoio acessíveis em www.adobe.com 
 
Créditos 
 
 Este texto  foi escrito por Joaquim Macedo (macedo@di.uminho.pt)  com base na 
bibliografia acima recomendada. Em particular foi usado como suporte a Visita 
Guiada do Adobe Premiere 6.0, Classroom in a Book e alguns textos da Adobe 
acessíveis em linha. 


